SeQent
Corporate Office
Suite 137 - 4500 Blakie Road
London, ON,
N6L 1G5
Canada
Phone: +1.519.652.0401

User and Installation Guide

FirstPAGE Alarm Manager Gateway for CIMPLICITY
V9.00
# Table Of Contents

Terms of Use .......................................................................................................................... 3

Version Information ............................................................................................................... 4

Edits ....................................................................................................................................... 4

Customer Service ................................................................................................................... 5

Support Contracts ................................................................................................................ 5

Location .................................................................................................................................. 5

1. Product Overview ............................................................................................................... 7

How it Works .......................................................................................................................... 8

2. Installation .......................................................................................................................... 9

Prerequisites .......................................................................................................................... 9

Installing the Application ...................................................................................................... 10

Installing FirstPAGE Alarm Manager Gateway for CIMPLICITY ....................................... 10

Adding Project Properties Options for FPAM Gateway for CIMPLICITY ...................... 12

3. Configuration ..................................................................................................................... 13

Configuring Key Components – Gateway Server ............................................................... 13

Adding a FirstPAGE Alarm Manager Gateway for CIMPLICITY Server ....................... 13

Enabling and Configuring Security ....................................................................................... 18

Configuring FPAM Gateway for CIMPLICITY Options .................................................... 21

Configuring the Gateway for CIMPLICITY options ......................................................... 21

4. Using FPAM Gateway for CIMPLICITY ........................................................................... 22

Viewing the Log Files .......................................................................................................... 23

Glossary ................................................................................................................................. 24
Terms of Use

Information in this document is subject to change without notice and does not represent a commitment on the part of SeQent. The software, which includes information contained in any databases, described in this document is furnished under a license agreement or nondisclosure agreement and may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure agreement. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of SeQent.

This software program and associated documentation are provided in an “as is” condition. In no event shall SeQent, its employees, directors or agents be liable for any loss or damage whatsoever (including, but not limited to, damages for loss of business profits, business interruption, loss of business information, or other monetary loss) arising out of the use of or the inability to use this software. By installing this software on your computer system you acknowledge that you have read and understood these terms and that you accept them.

© 2011 SeQent All rights reserved.

Printed in Canada

FirstPAGE Alarm Manager is a trademark of SeQent. Other brand and product names are trademarks, or registered trademarks, of their respective holders.
## Version Information

### Edits

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Author</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V9.00</td>
<td>February, 2010</td>
<td>K. MacLennan</td>
<td>Initial Document</td>
</tr>
</tbody>
</table>
Customer Service

Support Contracts

You may purchase a support contract for any of our products. Support is free for product trials and for the first 30 days of product ownership.

To view the SeQent support options, go to our web site (www.SeQent.com). To contact SeQent's Customer Support department please use the following methods.

Urgent Issues:

Normal Business Hours (Weekdays 9AM-5PM EST):
1. Dial: +1.519.652.0401
2. Select: Option 1
   If there is no answer then please leave a voice mail message with your contact information and your call will be returned promptly.

After Hours (Weekdays 5PM-9AM EST, Weekends and Canadian Holidays):
1. Dial: +1.519.652.0401
2. Select: Option 1
3. Listen to the on-call phone number provided
4. Call the indicated after hours number
   If there is no answer then please leave a voice mail message with your contact information and your call will be returned promptly.

Non-Urgent Issues / Questions

Normal Business Hours (Weekdays 9AM-5PM EST):
1. E-Mail: Support@SeQent.Com
2. Include the following information:
   - Contact Information
   - Product Name
   - Version
   - Description of the problem being experienced

Location

Corporate Office

4500 Blakie Road, Suite 137
London, Ontario
Canada
N6L 1G5
Phone: +1.519.652.0401
Fax: +1.519.652.9275
Email: info@SeQent.com
1. Product Overview

SeQent’s FirstPAGE Alarm Manager Gateway for CIMPLICITY is a FirstPAGE administration system that allows users to easily configure various rules that once triggered will send a message to a variety of FirstPAGE destinations, using a simple generic language.

Key Features:

- Hot reload for any configuration changes/additions
- Data items embedded in alarm messages are updated during the life of the alarm
How it Works

FirstPAGE Alarm Manager Gateway for CIMPPLICITY is another product in the FirstPAGE Suite of products and may reside on your FirstPAGE Alarm Manager Server or access a FirstPAGE Alarm Manager Server over a LAN or WAN connection.

The FirstPAGE Alarm Manager Gateway for CIMPPLICITY provides a bridge between CIMPPLICITY project alarms and the FirstPAGE Alarm Manager Server. Various routing rules can be defined by selecting available Resources, Alarms, Classes and alarm message text that have been configured in a CIMPPLICITY project. When one of these rules is met, message text can be dispatched to FirstPAGE Server, including embedding alarm and point values within the message text.

There are four valid alarm states that may be configured for each Routing Rule:

- **Generate** – Alarm is initiated via FirstPAGE Alarm Manager and the alarm becomes active by meeting the rules defined in CIMPPLICITY Workbench – Points on the Alarm tab
- **Acknowledged** – the alarm is Acknowledged by an operator with Alarm Viewer or the point is set up to Auto Ack in the Alarm Options of that point.
- **Reset** – the alarm is back within normal parameters or the point is set up to Auto Reset under the Alarm Options of that point.
- **Delete** – the alarm has been terminated and has met the rules under the Deletion Requirements in the Alarm Options.
Installation

Prerequisites

Before beginning the installation, it is important to determine the hardware and software requirements necessary for FirstPAGE Client to run efficiently. Review the following prerequisite list before the software is installed.

| Licensing               | General: Per server  
|                        | Licensing Options: None  
| Product Requirements   | FirstPAGE Alarm Manager Server V9.x  
|                        | CIMPLICITY v7.0+  
| System Requirements    | One of:  
|                        | Microsoft Win2K3 (SP1+)  
|                        | Microsoft WinXP (SP1a+)  
|                        | Microsoft Win2K8  
|                        | MicrosoftWin2K8R2  
|                        | Microsoft Win7  
|                        | Microsoft Win7-64  
|                        | Display: 800x600  
|                        | Disk Space: 200MB  
|                        | RAM: 128MB  
| Drivers                | TCP/IP  
|                        | MDAC V2.7 (SP1+)  

CIMPLICITY Configuration

In order for FirstPAGE Alarm Manager Gateway for CIMPLICITY to receive alarms from your CIMPLICITY project, all applicable alarms must be configured with valid resources. These resources must be attached to valid roles, which are in turn attached to valid users. If all pieces of this setup are not in place, the Gateway will not be able to receive these alarms. As a general rule of thumb, if an alarm is not captured by CIMPLICITY’s internal alarm viewer tool, the Gateway will not receive it.
Installing the Application

Before installing FirstPAGE for the first time, the following information must be considered:

- Determine which disk drive/directory your FirstPAGE Alarm Manager Gateway for CIMPLICITY software will reside on.
- Determine the Host name of the FirstPAGE Alarm Manager Server you will be connecting to.
- Determine the CIMPLICITY project name that will be utilized by the Gateway.

Installing FirstPAGE Alarm Manager Gateway for CIMPLICITY

1. Run FirstPAGE Alarm Manager Gateway for CIMPLICITY SETUP.EXE. Click Next.

2. After accepting the licensing agreement, select the installation destination directory.

3. Click Finish to complete the installation. The computer must be restarted before the FirstPAGE Alarm Manager Gateway for CIMPLICITY can be configured or operated.
Prior to utilizing the Gateway for CIMPPLICITY, you must create a client for the CIMPPLICITY server within the project. (This may already have been completed with another Gateway installation) You will be prompted for your machine name. Enter the Computer name and click OK.

To create a client for CIMPPLICITY:
1. From the Security option in your Workbench, select the Advanced folder, then double click on Client.

2. This is case sensitive. You will then be prompted to enter in the Default User ID. Enter ADMINISTRATOR then select the Trusted option so you will not be prompted for a password.
Adding Project Properties Options for FPAM Gateway for CIMPLICITY

Open your project in Workbench and select the Project menu in the toolbar, then select Properties. In the General tab under Project Properties, make sure Messaging Gateway option is checked as indicated on the following screen:
Chapter Three – Configuration

Configuring Key Components – Gateway Server

From within your CIMPLICITY project Workbench, go to the Messaging Gateway menu located under Equipment and select Administrator. The first time you start the Administrator, you will be asked to specify the details of your gateway server.

Adding a FirstPAGE Alarm Manager Gateway for CIMPLICITY Server

<table>
<thead>
<tr>
<th>DETAILS TAB</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Gateway Server</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Project ID</strong></td>
<td>A project ID will automatically be assigned when the new server has been saved.</td>
</tr>
<tr>
<td><strong>Project Name</strong></td>
<td>The Project Name is already added. This is the same name of the project that was opened in Workbench.</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td></td>
</tr>
<tr>
<td><strong>DSN</strong></td>
<td>This field will be populated when the server is saved.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Optional</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Optional</td>
</tr>
</tbody>
</table>

1. Once the Details tab has been configured, select the Settings Tab. The following screen appears:
2. Once the Settings have been defined, click the Security tab. The following screen is displayed:
3. To enable Security, you must select a Security Mode. Default selection is **NONE**. Your choices include:
   - **WINDOWS**
   - **FORD** (specific only to Ford users)
   - **CHRYSLER** (specific only to Chrysler users)

   For more detailed instructions on Security settings, see section entitled *Enabling and Configuring Security.*

4. Select the **CIMPLICITY** tab to configure alarm states. These states are global to all alarms within the project. The following is displayed:
5. Click the Save icon in the toolbar to save changes to the new server.

6. At this point, you must restart FirstPAGE Alarm Manager Gateway for CIMPLICITY. From the CIMPLICITY Workbench, select Process Control from the Runtime folder.
7. Double click to open this then change the status of FPAM from 'Halted' by selecting Start Process then OK.

8. The new server is now displayed with an assigned Project ID:
Enabling and Configuring Security

1. To enable Security, you must select a Security Mode. Default selection is NONE. Your choices include:
   - WINDOWS
   - FORD (specific only to Ford users)
   - CHRYSLER (specific only to Chrysler users)

Once a mode is selected and saved, a Users folder appears under the Tools section of the tree view. The Users folder allows the administrator to add destinations with limited access to various user applications.

2. Click on the Tools folder then select the Users folder. Right click and select New User or click the New icon in the toolbar. The following screen is displayed:
Configuring the Gateway

USER DETAILS TAB

User Details

<table>
<thead>
<tr>
<th>Username</th>
<th>Enter the Username for this account. This must be the Windows login username.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Select the Domain from the drop-down list of available domains</td>
</tr>
<tr>
<td>Password</td>
<td>Enter a Password for this username then confirm password.</td>
</tr>
<tr>
<td>Confirm</td>
<td>Confirm Password by retyping it.</td>
</tr>
<tr>
<td>Security</td>
<td>Select the level of security this user will have. Admin access gives users access to both Administrator and Client, if the application has both components. Default access gives users access to Client only.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional field.</td>
</tr>
</tbody>
</table>

3. Save your changes. The next time you start up the application, you will be prompted for a User ID/password and a valid Domain name before you are allowed access.

The first user entered must be an administrator with Admin security. The last user removed must also be an Admin.

4. The user will now be prompted for a UserID/password and a valid Domain name before the FirstPAGE Alarm Manager Gateway for CIMPLICITY can be accessed.
Configuring FPAM Gateway for CIMPLICITY Options

Before using FirstPAGE Alarm Manager Gateway for CIMPLICITY, configure the various settings that control the interface to the gateway. The Options menu allows users to set FirstPAGE Alarm Manager Gateway for CIMPLICITY details.

Configuring the Gateway for CIMPLICITY options

1. Click the Tools menu then select Options. The following screen is displayed:

![Options Menu](image)

2. The install kit will default the Data Source to FPAMGWCIMPADMIN, pointing to your Gateway for CIMPLICITY administrator database.

3. The Server Reload option allows the user to select when they want a reload to server: with every change, or only when requested.
Using FPAM Gateway for CIMPLICITY

The FirstPAGE Alarm Manager Gateway for CIMPLICITY user interface is conveniently displayed in a tree view.

Once configured, there is very little interaction between the user and this application. The management of this application takes place within its associated FPAM Administrator agent.
Viewing the Log Files

In each application, you are able to view the log files associated with the various components of the software. The log files contain an accurate history of every transaction and modification made to the database. Log files are important because they ensure the integrity of the data and provide a means of data recovery.

To View:

1. Select View to get the View Admin Log or View Server Log options.

2. Double-click the log entry for further information.

3. Click the Filters button and choose viewing options to display only the desired information.

4. The Events On: field defaults to the current day.

5. The Status Message field can be used to search for a portion of the message in the log. Only certain characters may be used in this field. When matching the special characters left bracket ([]), question mark (?), number sign (#), and asterisk (*), enclose them in brackets. i.e. To find all log items that start with [ enter in [[]* in the Status Message field.

The common search characters are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Match Made</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Any single character</td>
<td>Text in the log is ABC, DBC and XYZ. If ?BC is used in the Status Message field, only ABC and DBC will be returned.</td>
</tr>
<tr>
<td>*</td>
<td>Zero or more characters</td>
<td><em>Initiated</em> in the Status Message field would return all log items with the word 'Initiated'</td>
</tr>
<tr>
<td>#</td>
<td>Any single digit (0-9)</td>
<td>Text in the log is Device1, Device5, Device8, Device10. Keying in Device# in the Status Message field, will return Device1, Device5, and Device8.</td>
</tr>
</tbody>
</table>

6. Select the Automatic Refresh option to automatically refresh the log file based on the seconds specified.
Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If changes are made to the server configuration the administrator notifies the engine to reload its running configuration either automatically or on user demand. An example of an administrator component is FirstPAGE Administrator.

This administrator allows you to maintain the FirstPAGE server's engine configuration.

Administrator Kit

An administrator kit contains the product’s administration component only. After installing this kit on a workstation you may utilize any of the features of the Administrator component.

Alarm

Generates alarms for points that are in an alarm state. It can generate alarm messages about system events, such as device failures, and device statuses.

Class

Alarm class is the order in which an alarm appears relative to other alarms. Alarms with similar characteristics are usually grouped by class.

Distribution List

A FirstPAGE Server distribution list is a collection of marquees, which can be sent a message with a single transaction. Similar to an e-mail distribution list a client who initiates a transaction with a distribution list will automatically send the same message to all associated marquees.

Point

Data that can be collected from various devices such as programmable controllers. Point configuration defines where a point originates, how the data is collected, and what constitutes an alarm state.

Resource

The physical or conceptual units that comprise your facility and can be anything from devices and machines to stations where work is performed.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client component is also included with this kit. The server kit is usually installed on a centralized host and is utilized by one or more clients or gateways. An example of a server kit is FirstPAGE Server. This kit contains the FirstPAGE engine, administrator and client.